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Type-14 Budget Revisions




-~ Budget Revision Types
Revision Type
_ Twell

Impacts e Certified & Authorized e Authorized Only e Authorized Only
OSBM * Yes * Yes * No
Approval
e Realighments other than
Action e Adjustments required by e Adjustments allowed by transfers or MErE e &
law or distributions from law but not delegated budget receipts up to
a reserve account to universities OSBM-delegated
threshold.
Transfer
Across Funds ¢ Yes e Yes
* Yes
R/NR * R - Realignments
e Both e Both

e NR - Receipts



-~ Budget Revisions - Type 14 (Internal)

Revisions to Authorized Budget
G.S. 143C-6-4(g) and G.S. 116-30.2

* Budget revisions that agencies can approve internally are known as Type
14 revisions.

 UNC Type 14 Authority based on GS 116-30.2 and State Budget Manual Section
3.6.6.

e Realignments within a budget code that do not impact 57xxxxxx (Reserve) or
58xxxxxx (Transfer) accounts (Recurring or Nonrecurring)

 Position creation — All position actions not caused by a Type 11 or Type 12
revision (Recurring or Nonrecurring)

e Budgeting receipts up to OSBM-delegated threshold (Nonrecurring only)



Type 14 Updated Guidance- Receipt Adjustments

Starting in FY26, OSBM increased the receipts threshold allowed on Type 14
revisions. The threshold is set by budget code based on the BD 307 certified
receipts budget for that budget code:

. SZﬁ_K for budget codes with a certified receipts budget of less than $100
million

* S100K for budget codes with a certified receipts budget of equal to or
greater than $100 million

Resources:

* OSBM Common Agency Requests

* Internal Budget Revision Receipt Adjustment Threshold
e State Budget Manual (updated for FY 2026)

* UNC Budget Revision Authority Guide



https://www.osbm.nc.gov/budget/common-agency-requests
https://www.osbm.nc.gov/budget/common-agency-requests
https://www.osbm.nc.gov/budget/common-agency-requests/internal-budget-revision-receipt-adjustment-threshold
https://www.osbm.nc.gov/budget/common-agency-requests/internal-budget-revision-receipt-adjustment-threshold
https://www.osbm.nc.gov/budget/budget-manual
https://www.osbm.nc.gov/budget/budget-manual
https://www.osbm.nc.gov/unc-budget-revision-authority-guide/download?attachment
https://www.osbm.nc.gov/unc-budget-revision-authority-guide/download?attachment

Authorized Receipt Budget Limits

* G.S. 116-30.3A

§ 116-30.3A. Availability of excess receipts.

Notwithstanding the provisions of Chapter 143C of the General Statutes, receipts within The
University of North Carolina realized in excess of budgeted levels shall be available, up to a
maximum of ten percent (10%) above budgeted levels, for each Budget Code, in addition to
appropriations to support the operations generating the receipts as approved by the Director of the

Budget. (2006-203, s. 4; 2023-134, s. 4.10(d).)

* Calculated based on the certified receipt budget, for each budget code,
cumulatively for the fiscal year

* The maximum allowable authorized receipts to budget on Type 12 or 14 is
calculated as follows: 10% of certified receipts budget on the RK 325/BD 701
MINUS authorized receipts budgeted YTD on Type 12 and 14 revisions

Example:

Certified Receipts

Authorized Receipts

$1,000,000 $1,075,000
10% of Certified |Authorized Receipts Budgeted YTD | Receipt Authority Available to Budget
$100,000 $75,000 $25,000




Navigating NCFS and IBIS




Navigating NCFS Reports — Searching

* You can search NCFS reports by name if you are looking for a specific
report and don’t recall the pathways to navigate directly to it

You are on the PRODUCTION environment.

Reports and Analytics @

All Folders »»

Filter ‘ All types v‘ | Favorites ‘ Clear Filters

NC Budget to Actual (701) Excel Report (RPTRTF
==l

fehared/Custom/FER Custom/Report/General Ledge

NC Budget to Actual (701) Excel Report (RFTRTR019)

| Browse Catalog |

Sort By | Last Updated Date -

r N
Created By

Batch User
Last Updated By 11325 7:25 AM

il Catalog
v & & W]
4 Search

Search

E teh [
Location all
Sub-Folders u

Type Al

v




Navigating NCFS Reports — Favorites

»You can also “Favorite” NCFS reports that you use regularly

»These “Favorite Reports” will show on the Reports and Analytics page

in NCFS

_ ‘You are on the PRODUCTION environment.

Reports and Analytics @

All Folders »

Filter | All types v| | Favorites | Clear Filters

NC Budget to Actual (701) Excel Report (RPTRTF

Jshared/Custom/FER Custom/Report/General Ledge

MC Budget to Actual (701) Excel Report (RFTRTR019)

NC Chart of Accounts Combinations Report (RP”

fshared/Custom/FER Custom/Report/General Ledge

MC Chart of Accounts Combinations Report (RPTRTR157)

Batch User
1/M13/25 7:25 AM

Batch User
1/8/24 4:32 AM

»

Last Updated Date »

T TU=TIE RO ¥

NC Budget to Actual (701) Excel Report (RF
MC Budget to Actual (701) Excel Report (RPTRTRO14
fShared Folders/Custom/FER Custom/Report/Genera
Open More v

['es Schedule
(&l History

i@ Jobs

(& Copy

I v Add to Favorites

7 Create Shortcut

B Archive

& Properties




Navigating NCFS Reports — Report Format

»To change the report format, select the icon for the current type and
a drop down will let you select the different options for the report

NC Budget to Actual (701) Certified Report (RPTBEO0O6) Home Catalog Favorites » Dashboards v Createw O

Agency Al v
Budget Code Al v
Period Current Period v
Report Mode All Sections v  Apply
NC Budget to Actual (70... £ =[O &+ @
[@] HTML
PDF

Excel (* xlsx)
[3] CsSV




Navigating NCFS Reports — Schedule Reports

ctual (701) Excel Report (RPTRTR019)

Agency 0300-OFFICE OF THE GOVE w Budget Code 13005-OFF OF STATEBUDC w Budget Fund Al v
Agency Management Unit All v Agency Program Al v Funding Source All v
Inter Fund Al v Future 1 All v Future 2 All v

Period Current Period v | Apply

NC Budget to Actual (70...

Account All
Project All

Future 3 Al

Home

Catalog

Favorites v Dashboards v Create v Open

Jobs

(& Job History
Republish from History
Share Report Link »

Online Diagnostics 3

4 Qverview
General Created by 02171735 Qutputs Oufput1
Report Name /Custom/FER Cusiom/Report/General Ledger/MC Budget to Actual (701) Excel Report (RFTRTR0O19)NC Budget to Actual (701) Excel Report (RFTRTR019).xdo Destination
Schedule Start on Nov 14, 2025 8:00:00 AM Recur Daily MNotification

General Output | Schedule  Notification

4 Define Schedule Time
Frequency Daily v

Every 1  day(s)
Start Mov 14, 2025 8:00:00 AM E“e (UTC-05:00) New York - Eastern Time (ET)

End Mov 14, 2026 8:00:00 AM E“e (UTC-05:00) New York - Eastern Time (ET)

4 Define Schedule Trigger

(] Use Trigger

Return  Submit @




—:: IBM Cognos Analytics

1/2 Alerts

'm' Home

Q Search
D My content

I:E Team content

® Recent

Team content

IBIS Exception Reports
5/30/2014 1:23 PM

IBIS Reports
9/22/2022 12:45 PM

IBISNCFSReports
9/12/2025 2:14 PM

OSBM Analyst
/162025 10:22 AM

Samples
4/19/2011 10:36 AM

Self Service Reports
3/5/2024 5:02 PM

Self Service Reports (Legacy)
2/21/2018 11:10 AM

System Run Reports
8/29/2023 3:20 PM

System-Run Reports (Legacy)
2/21/2018 10:53 AM

IBIS Reports —Self Service v System Run; Legacy v Non-Legacy

(L) What's New To read about what's new in Getting Started,

* Self Service: report parameters
must be populated

e System Run: default report
parameters run overnight

* Legacy: Information as it relates
to NCAS

* Non-Legacy: Information as it
relates to NCFS



IBIS Reports - Searching

—:: IBM Cognos Analytics

1/2 Alerts

'G]' Home

(1) What's New To read about what's new in Getting Started, click

Search

Q Search

My content
Team content

Recent

© kK [

-t

RK 15

@® 50 Results

m

RK 15 Multi Purpose Report

Team content > Self Service Re ... Execution Reports

RK 15 Multi Purpose Report

Team content > Self Service Re ... Execution Reports

RK 326 Deviation Report

Team content > OSEM A ... RK 326 Deviation Report

RK 349 Over-Expenditure Report

Team content > System- ... Over-Expenditure Report

RK 326 Deviation Report

Team content > OSBEM Analy=st > Hold/Archive

RK 349 Over-Expenditure Report

Team content > System-Run R ... Execution Reports

—:: IBM Cognos Analytics

1/2 Alerts

()

Home

Search

My content

Team content

Recent

Search

RK 15

50 Results

@

RK 15 Multi Purpose Report

Team content > Self Service Re ... Execution Reports

RK 15 Multi Purpose Report

Team content > Self Service Re ... Execution Reports

RK 326 Dewviation Report

Team content > OSEM A ... RK 326 Deviation Report

RK 349 Over-Expenditure Report

Team content > System- ... Over-Expenditure Report

RK 326 Dewiation Report

Team content > OSEM Analyst > Hold/Archive

RK 349 Over-Expenditure Report

Team content > System-Run R ... Execution Reports

RK 402 Capital Report

Team content > OSEM Analyst ... Execution Reports

(i) What's New To read about what's new in Getting Started, click More Info.

Last modified
10/27/2025, 11:12 AN

S

[» Runas

¢ Edit report

Create report view

&l

i View versions

«2 Share

O Copy

~» Create shortcut

= Properties




IBIS Reports — Select Report Format

> |BIS Reports

IBM Cognos Analytics
1/2 Alerts £ : (© What's New To read about what's new in Getting Started, click More Info. Run as
m Home e« [ » ..8 > DBudget..Reports + &% Tl
. Run in background C)
Q Search —  Allotment Tracker — BETA - s a
Wl 71112024 2:58 PM ?I'P- <
:_,';,/
- oy
—  BD 606 Budget Revision Report ) Excel
D e i W 10/20/2025 4:13 PM
@®
—. RK 15 Multi Purpose Report () Excel Data
(2] Team content L 10/20/2025 3:14 PM . Samnlas - )
[ Runas
— RK 312 Budget Revision Count Report )
® Rize L 10172025 3:27 PM ; our's ‘® PDF
¢ Edit report Jild
— RK 314 Budget Revisions List Report /--\,
W gr24/2025 2:32 PM i@ Create report view (P HTML
— RK 315 Repeat Bu ... Revision List Report — .
Ll g/24/2025 11:35 am k] View versions (O csv
—  RK 316 Count of Exter ... Year and Quarter «2 Share
U4 10/7/2025 3:07 PM Cj *ML
— RK 317 Journal Entry Report D Copy
W q0/7/2025 3:07 PM
£> Create shortcut Prompt me
— RK 318 Budget Revisions Re ... List Report
W gr25/2025 8116 AM !
= Properties
— RK 323 Change in Budgeted Receipts ]




IBIS Reports — Change report format after pulling report

RK 15 Multi Purpose Report

[ Run HTML ) What's New To read about what's new in Reporting, click More Info. Dismiss

— Draw ~ & AD - + = 1 | ofto | ) | (B

Run Excel

Run Excel data RK15 - Budget Revision Multipurpose List Report

Revisions at Budget Code Level
=] Run CSV
te Budget and Management - General Fund
Run X 2025.26 2026.27
® Revision # Status Approval Dt Actual Dt Requirements Receipts Appropriation Positions Requirements Receipts Appropriation Positions Budget Revision Title
Approved $12,785,589 $1,106,402  $11,679,187 75.000 $12,785,589 $1,106,402  $11,679,187 75.000 Original Appropriation Bill

12-0001 Approved  09/19/2025 09/19/2025 50 $0 $0 0.000 50 50 50 0.000 RR Realign Salary reserve in 1
12-0003 Approved  09/19/2025 09/19/2025 $101,567 $101,567 $0 0.000 $101,567 $101,567 $0 0.000 RR Budget Receipt support Posi
12-0002 Approved  09/19/2025 09/19/2025 $140,713 $140,713 $0 1.000 $140,713 $140,713 $0 1.000 RR Change the funding Source f
12-0009 Approved  09/30/2025 10/01/2025 50 $0 $0 0.000 50 $0 $0 0.000 Realign Salary Reserve in 1300
11-0006 Approved  09/30/2025 10/06/2025 $4,131 $4,131 $0 0.000 $4,131 $4,131 $0 0.000 Budget Health Ins Increase Rec
12-0007 Approved  09/30/2025 09/30/2025 $252,530 $252,530 $0 2.000 $252,530 $252,530 $0 2.000 Set up time limited Auditors P
12-0010 Approved  09/30/2025 10/14/2025 ($88,344) (588,344) $0 (1.000) ($88,344) ($88,344) 50 (1.000) Correct the salary control in
11-0005 Approved  09/30/2025 10/07/2025 $0 $0 $0 0.000 $0 $0 $0 0.000 Budget Medical Insurance Incre
11-0004 Approved  09/30/2025 10/07/2025 30 $0 $0 0.000 $0 $0 $0 0.000 Budget Retirement Increase OSB




Foundational Reports

»BD 307 Original Report

* |BIS Location: Team Content>Self Service Reports>Certification Reports>BD 307
Original Report

»RK 325 Certified and Authorized Budget Report

* |IBIS Location: Team Content>Self Service Reports>Budget Execution Reports>RK 325
Certified and Authorized Budget Report

»BD701 NC Budget to Actual (701) Certified Report (RPTBEOO06)

* NCFS Location: Tools>Reports and Analytics>shared/Custom/FBR
Custom/Report/Budget/NC Budget to Actual (701) Certified Report (RPTBEOO6)

»BD701 NC Budget to Actual (701) Detailed Report (RPTRTR152)

* NCFS Location: Tools>Reports and Analytics>shared/Custom/FBR
Custom/Report/Budget/NC Budget to Actual (701) Detailed Report (RPTRTR152)

»BD701 NC Budget to Actual (701) Excel Report (RPTRTR019)

* NCFS Location: Tools>Reports and Analytics>shared/Custom/FBR
Custom/Report/Budget/NC Budget to Actual (701) Excel Report (RPTRTR0O19)



_— Foundational Reports

»BD307 — Certified Budget Report

. Stgtlc report —once the budget is certified, Original vs. Revised BD 307 Report
this report will not change .
e Original reflects the budget as
* Signed BD 307 Reports can be found on approved by the General Assembly in
OSBM's website foIIowing certification the first year of the biennium (even
years)
. * Revised reflects the budget as
Two versions: amended by the General Assembly in
e BD 307 Original or Revised Report the second year of the biennium (odd
 BD 307 — All Segments RN,

18


https://www.osbm.nc.gov/budget/certified-budget

Foundational Reports

»BD 307 Original Report

* |BIS Location: Team Content>Self Service Reports>Certification Reports>BD
307 Original Report

Certified Budget - Original (BD307)

Choose Report
Biennium Budgetary Reporting Unit

* |(@) All Parts
() Cover Page * [2025-27 v * | 010-General Assembly a
E::: gzmmz;y Ey ;‘;’:;um 020-Administrative Office of the Courts [ |
(:E' Detail bnyuid 022-Indigent Defense Services
- 030-Office of the Governor
031-Office of State Budget and Managemen
040-Office of the Lieutenant Governor
050-Department of Secretary of State
060-Office of the State Auditor
N7N-Nenartment of State Treasurer v
4 S

»
Select all Deselect all

Click Here For Budget Codes

Budget Code Status Status Options:
* - - - Genera & * A d hd 1
13005-13005-OSBM - General (Approve Draft: Forms not submitted to OSBM

13006-13006-0SBM - Surveying and Mappir'
13085-13085-0SBM - Reserve for General £

23005-23005-0SBM - Fines and Penalties OSB M . FO rms su b m Itted to OS B M
23006-23006-03BM - S i d M .

23009-23009-05BM - D?jsr:;z:gzl?ef R;‘:; Ap p roved ° All. fo rms a p p rove d by
23013-23013-COVID-19 Recovery Act O S B M

23014-23014-0SBM GF - Special Revenue
23M7-23M7-05BM-IT PROLIFCTS v
4

Selectall Deselect all




— Foundational Reports

»RK325 — Certified and Authorized Budget Report

* Reports current certified and authorized budget, as amended throughout the
year via budget revisions

* Used to reconcile Banner/NCFS to IBIS budget
* Updates every hour

Certified And Authorized Budget Report (RK 325)

Report Type Biennium Approval Date

* @}ALL * | 2025-27 v * Sep 30, 2025 -
_) Summary By Fund (Dollars)
::) Summary By Account (Dollars)

(

(
() Detail By Account (Dollars)
s

(
(

_)Summary By Fund (FTE)
_) Summary by Account (FTE)
_) Detail By Account (FTE)

Budget Code
Budgetary R rting Unit
s e A * 13005-0SBM - General a
W | 031-Office of State Budget and Manageme V| 13006-0SBM - Surveying and Mapping - Ge'
13085-05BM - Reserve for General Assemb

23005-0SBM - Fines and Penalties

IBIS Location: Team Content>Self Service Reports>Budget Execution Reports>RK 325 Certified and Authorized Budget Report

20



Foundational Reports

»BD701 NC Budget to Actual (701) Certified Report (RPTBEOO6)

* NCFS Location: Tools>Reports and Analytics>shared/Custom/FBR Custom/Report/Budget/NC
Budget to Actual (701) Certified Report (RPTBEQQ6)

RK325-Budget Approved as of 09/30/2025
?g,f‘lnls Summary by Fund
Biennium 2025-27
13005-State Budget and Management - General Fund
Budget Budget 2025-26 2025-26 2026-27 2026-27
Fund Fund Title Certified Authorized Certified  Authorized
Requirements.
100276 GOV 1310 OFFICE OF STATE BUDGET BC 13005 $12,794,000 $13,189,076 $12,794,000 $13,189.076
Requirements $12,794,000 $13,189,076 $12,794,000 $13,189,076
North Carolina Financial System Receipts
Office of State Controller 100276 GOV 1310 OFFICE OF STATE BUDGET BC 13005 $1,114,813 $1,509,889 $1,114,813 $1,500,889
Novth Carafina Financial System .
NC Budget to Actual (701) Certified Report (RPT-BE-006) Receipts $1,114,813 $1,509,889 §1,114,813 $1,509,889
/21/2025 10:55:16 Al N
10/21/2025 10:55:16 AM Net Appropriation $11,679,187 §$11,679,187 $11,679,187 §$11,679,187
Parameters
Agency ‘ Budget Code | Period | Report Mode ‘
[ 0300-OFFICE OF THE GOVERNOR [ an | Sep-25 | All Sections |
0300-OFFICE OF THE GOVERNOR Certified Date
13005-OFF OF STATE BUDGET AND 10/15/2025
MANAGE
*#* Budget Code Recap ***
Budgeted Actual Unexpended /Unrealized Encumbrances
Account Description Certified Authorized Current-Month Year-To-Date Certified Authorized Obligations Unpaid Invoices + Rate
Inventory Receipts
l,\prndi'um\ 12,794 (HK.00 13,189 (76.00 O78,573.59 3,244 104.79 1,549 895.21 0,944 971.21 0.00 10083100 1.01
Revenues 1,.114,813.00 1,500,889.00 206,840.51 477,902.92 636,910.08 1,031,986.08 .00 0.00 127
Appropriations 11,679,187.00 11,679,187.00 771,733.08 2,766,201.87 8,012,985.13 8,012,985.13 0.00 100,851.00 0.98
Cash Analysis
Beginning Balance 0.00
+ Allorments 2.909,435.00
+ Cash Receipts 477 ,902.92
- Cash Disbursements 3,244,104.79
+ Assets 0.00
+ Liability 0.00
+ Equity (.00
= Ending Balance 143,233.13

Additional Assets
| Total Availability 143,233.13




Foundational Reports

»BD701 NC Budget to Actual (701) Excel Report (RPTRTR019)

* NCFS Location: Tools>Reports and Analytics>shared/Custom/FBR Custom/Report/Budget/NC
Budget to Actual (701) Excel Report (RPTRTR019)

North Carolina Financial System
bt Office of State Controller
INC Budget to Actual (701) Excel Report (RPT-RTR-015)
10/21/2025 11:43:13 A
[Parameters
gy DNOFFICECFTHE  [FundingSouce 41
GOVERNOR
IBucget Code A1 [Project A
[Bucget Fand Al | nter Fand Al
hccour a Funwe a
sgene Vamagoment Dt A1 Fuwe? a
gy Program 1 Futwe3 A
JPercd ey
Paid FhcalYer gy Agerey Dosripton Bl Code | Budge Cole Descpon | Butge Fund | Bl Fd Dsptr | Accomn Tyge | Aecomt | Ao Doscgtin | AMU | ANUDocipion | AgrPogom | AgeorProgam | FunligSouwse | FudingSome | Pofect | PwccDoipion | ToerFand | Do Fnd Dosripion | Futwel | Fuwe? | Fawmed | VID Cortfed udget | YT Authoiaed B | ComoncPerd Acus | QTDAcoals | YIDActub | CorfbdBimee | AuhodedBiaee | UTD Commimens | LD Oblgedons | LTD Unpadovoies
Descipion Deseipion ;
3 i W OMEGEE | @0 |0G0n ORI @i eovan EEVENE | 4M05 [NCBRDES OGO |DEFATLTAND WON  |DERALLTAGENCY WD [DOEIGNATED Q0O [DEEATLTPRQJECT W0 DEFAUTRUDGETECND] 060 | DO | GOl EET EET [P EYITE IR EE EE o o o
GOVERNCE cENERL ADMSTRTION BT o R
13000
3 00 OFFICE CF THE 4 3000 00201 GOV 1112 [EEVENUE 44320000 [SALE OF SURPLLS 0000000 DEFAULT AMU 000020 DEFALLT AGENCY 0000 [UNDESIGNATE! (00002000 [DEFAULT PRCJECT %00  [DEFAULTBUDGETFUND| 0600 020000 00000 00| 00| 7200( 1341 134.10] (13410 (13410 0.00) 0.00) 0.00)
GOVERCR |ADATNISTRATION BC IroRERTY moGra
s
3 I G0 OFECTE | G |0SwuG0v O il rE\'mJ [EXPENDITURES [ 50000 [FPAREGRLARES | i [DEFAUIT AT OO |DEFALTT AGENCY W e W0 [DEFATLTPROJECT W DEFAULTRUDGETRCND] 060 | Do | il 900 ; e ) ) ) )




Base Budget Reports

»\WSI Reports

* |BIS Location: Team Content>Self Service Reports>Budget Development
Reports>Worksheet | Reports>Worksheet | Report

* |IBIS Location: Team Content>Self Service Reports>Budget Development
Reports>Worksheet | Reports>Worksheet | Report-All Segments-Raw
Data



-~ Base Budget

» Worksheet | Report (aka Base Budget Document)— Provides
expenditures, revenue, and position counts by account by budget
fund.

* Published with Governor’s Recommended Budget on OSBM'’s website

» Worksheet | Report — All Segments — Raw Data
* Provides Worksheet | data at a detail chart of account level.

* This allows universities to review the budget as it will ultimately be transferred
to NCFS.

* This report is available in Excel.


https://www.osbm.nc.gov/media/4269/download?attachment

Worksheet | Report

Recommended Base Budget (Worksheet I)
% élBlS Summary By Account
Biennium : 2025-27
Status : Approved
030-Governor's Office - General Fund
13000-Governor's Office - General Fund

Requirements

PERSONAL SERVICES

Account Account Fund Inter Actual Certified Authorized IncriDecr Total Incr/iDecr Total
Code Title Source Fund 2023-24 2024-25 2024-25 2025-26 2025-26 2026-27 2026-27
51110000 EPA-REG SALARIES XXX $3,642,415 $3,825,677 $3,825,677 50 $3,825,677 $0 $3,825,677
51110000 EPA-REG SALARIES 2XXX $722,829 $726,794 $757,181 50 $757,181 $0 $757,181
51140000 SEC/COUNCIL OF ST SAL XX $198,120 $208,026 $208,026 50 $208,026 §0 $208,026
51460000 EPA&SPA-LONGVTY PAY XXX $63,162 $67,288 $67,288 $0 $67.288 $0 $67.288
51460000 EPA&SPA-LONGVTY PAY 2XXX $6,004 54,912 58,562 50 $8.,562 $0 $8,562
51510000 SOCIAL SEC CONTRIB XX $285,280 $329,783 $329,783 50 $329,783 §0 $329,783
51510000 SOCIAL SEC CONTRIB 2XXX $52,475 $52,454 $58,580 $0 $58,580 $0 $58,580

25



Budget Set Up /Repeat Revisions Reports

»RK 340 Budget Revision Report Raw File
»RK 323 Change in Budgeted Receipts
»RK 317 Journal Entry Report

»RK 314 Budget Revisions List Report
»RK 315 Repeat Revision Report List

IBIS Location: Team Content > Self-Service Reports > Budget
Execution Reports > RK 314 Budget Revisions List Report



RK 340 — Budget Revision Report Raw File

 The RK 340 can give you an Excel file with all the budgetary
information from approved revisions for a selected biennium

BIENNION_TITLE BUDGET_CODE BUDGET_FUND ACCOUNT_CATEGORY ACCOUNT_CODE ACCOUNT_TITLE FUNDING_SOURCE_CODE AMU_CODE NCFS_PROGRAM_CODE PROJECT_CODE TNTER_FUND_CODE REVISION_NUWBER REVISION_TYPE
2025-27 3005 00278 E ¥ 1560000 MED INS CONTRIB %000 foooooo Toooooo finoonoooon fooooo 11-0008 Fi1
202527 Fia005 00278 R 8300026 REIMB-DEPT OF TRANSPORTATION fooo fooooon Toooooo foooooooon Mooooo 11-0008 Fi1
2025-27 Fi3005 Fio027s R %3300219 REIMB- OSBM Moo foooo00 Too0000 Tooona0000 fooooo 11-0006 Fi1
2025-27 3005 00278 E ¥ 1550000 MED INS CONTRIB Fiooo fnoooon Tioooooo fnooooooon fooooo 11-0005 Fi1
202527 Fia005 00278 E % 7208000 RES-STATE HEALTH PLAN Mooo fnoooon Toooooo fnooooooon Mooooo 11-0005 Fi1
2025-27 Fi3005 Fion27s E 1520000 REG RETIRE CONTRIB Finoo Tooooon Tioooooo Tnoonoooon Finooon 11-0004 P
2025-27 Fian05 00278 E 7206000 RES-ST RETIREMENT SY'S CON fooo Mooooon Toooooo foooooooon fooooo 11-0004 Fi1
202527 Fiz005 00278 E 1520000 REG RETIRE CONTRIB %000 Tooo000 Too0000 Tooonoo000 Tooo00 11-0008 Fi1
2025-27 3005 Fio027s R E.8300026 REIMB-DEPT OF TRANSPORTATION fooo fooooon Tioooooo fnooooooon fiooooo 11-0008 Fi1
2025-27 Fi3005 00278 R 8300219 REIMB- OSBM Mooo Mooooon Toooooo Tnooooooon Moooon 11-0008 Fi1
REFERENCE _TITLE REPORTING_STATUS | APPROVAL_DATE EFFECTWVE_DATE UPDATED_DATE RECURRENCE_TYPE MONTH | Quarter CERTIFIED_REQUIREMENT_AMT_vR1 CERTIFIED_RECEIPT_AMT_YR1 CERTIFIED_REQUIREMENT_FTE_YR1
Budget Health Ins Increase Receipt Positions Fv2 Approved 08/30/2025 07/01/2025 1040642025 R 9 QTR 413 0 o
Budget Health Ins Increase Receipt Positions Fy'2 Approved 093042025 07/01/2025 10/06/2025 R 9 QTR1 0 405 0
Budget Health Inz Increase Receipt Positions Fy'2 Approved 09/3042025 07/01/2025 10/062025 R 9 QTR1 0 3726 0
Budget Medical Insurance Increase - OSBM Y2026 Approved 09/3042025 07012025 10/0712025 R 9 QTR1 27,054 0 0
Budget Medical Insurance Increase - 0SBM Fy2026 Approved 09/3042025 07/01/2025 1040742025 R 9 QTR -27,054 0 0
Budget Retirement Increase OSBM Appropriations P2 Approved 09/3002025 07012025 1040712025 R 9 QTR1 43410 0 o
Budget Retirement Increase OSBM Appropriations Fy'2 Approved 09/3042025 07012025 10/0712025 R 9 QTR1 43410 0 0
Budget Retirement Receipt Positions 100275 Approved 03012025 07i01/2025 10/06/2025 R 9 QTR1 4,280 0 0

IBIS Location: Team Content > Self-Service Reports > Budget Execution Reports



RK 323 — Change in Budgeted Receipts

RK 323-Change in Budgeted Receipts
7%¢IBIS Biennium: 2025-27
Revision#  Approval Date Description 2025-26 2025-26 2026-27 2026-27
Change Balance Change Balance
BD307 Amounts £4,009,217 84,009,217
11-0001 09/10/2025 Management Flex Carryforward FY25 to £1,404,000 $5413.217 50 54,009,217
FY26 $5,413,217 $4,009,217

IBIS Location: Team Content > Self-Service Reports > Budget Execution Reports
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RK 317 — Journal Entry Report

* Use the RK 317 - JE/BC Balances Option to see if a Journal Entry has
been approved and to check total appropriation changes

Journal Entry/Budget Codes and Fund Code Balances

Report Type Biennium

Volume

* @ JE/BC Balances * | 2025-27

v| *[1-Education

(_) Change in Fund Code Balances

7CIBIS

U10-University of North Carolina

Journal Entries and Budget Code Balances

Biennium 2025-27

16011-UNC Board of Governors - Institutional Programs

. 2025-26 2025-26  2026-2027 2026-2027
‘ém';l :awsmn Eﬂ&mad I:;?:f;:: Description Authorized Balance Authorized Balance
Change Certified Balance Changa Certified Balance
0671 110040 102412025 16088 26 Enroliment Chanae Budaet AD. ($1,282,173) $107.638,681 ($1,282,173) $113 685,490
) Arofiment L-hange Budge $107,638,681 $113,685.490
G-0671 110049 10/24/2025 16090 FY26 Enrollment Change Budget ADJ ($2,420,503) $105218,178  {32.420.503) $111,264,987
$105.218,178 $111,264 987
($474,313) $104,743.865  ($474,313) $110,790,674

G0671 110049 10/24/2025 16092 FY26 Enroliment Change Budget ADJ
Arofiment L-hange Bucge $104,743 865 $110,790,674
G-0671 110049 10/24/2025 16004 FY26 Enroliment Change Budget ADJ (347,702) $104,696,163 ($47,702) $110,742,972
- Arofment L-hange Bucee $104,696,163 $110,742,972

IBIS Location: Team Content > Self-Service Reports > Budget Execution Reports

29



RK 314 Budget Revisions List Report

RK314-Budget Revisions List Report

Biennium Budget Reporting Unit Budget Codes

* | 2025-27 v|  *|031-Office of State Budget and Management v | * 13005-0SBM - General

i
13006-0SBM - Surveying and w'
13085-05BM - Reserve for Gen
23005-0SBM - Fines and Penal
23006-05BM - Surveying and h
23009-05BM - Disaster Relief F
23013-COVID-19 Recovery Act
23014-0SBM GF - Special Rew

PAMT7-05BM-IT PROUFCTS ¥
4 S 3

Select all Deselect all

IBIS Location: Team Content > Self-Service Reports > Budget Execution Reports



RK 314: Budget Revisions List Report

71eIBlS e S e
13005_State Budget and Management - General Fund
2025-26 2028-27
Revision # Status Recurring I;. I.: Bizse Requirements Receipts Appropriation Positions Requirements Receipts Appropriation Positions Budget Revision Title
udge
Approved Mo $12,785,589 $1,106.402  $11,679.187 75.000  $12,785,589 $1,106,402  $11,679,187 75.000 Original Appropriation Bill
11-0004 Approved R Mo 50 30 0 0.000 0 0 50 0.000 Budget Retirement Increase OSB
11-0005 Approved R Mo 50 50 g0 0.000 $0 g0 $0 0.000 Budget Medical Insurance Incre
11-0006 Approved R Mo $4,131 $4,131 $0 0.000 $4,131 54,131 $0 0.000 Budget Health Ins Increase Rec
11-0008 Approved R Mo $4,280 $4,280 50 0.000 $4,280 4,280 50 0.000 Budget Retirement Receipt Posi
12-0001 Approved R Mo 50 50 g0 0.000 $0 g0 50 0.000 RR Realign Salary reserve in 1
12-0002 Approved R Mo $140,713 $140.713 20 1.000 $140,713 $140,713 $0 1.000 RR Change the funding Source f
12-0003 Approved R Mo $101,567 $101.567 0 0.000 £101,567 $101,567 $0 0.000 RR Budget Receipt support Posi
12-0007 Approved R No $252,530 $252,530 50 2.000 $252,530 $252,530 50 2.000 Set up time limited Auditors P




RK 315: Repeat Budget Revision List Report

* Populated each year after repeat revisions from previous year have
been loaded into IBIS

RK 315 Repeat Budget Revision List Report
Biennium 2025-27

Biennium BRU Code BRU Title Budget Code Revision Current Yr Status Revision Previous Yr
2025-27 10 University of North Carolina 16010 11-0026 Approved 11-0154
2025-27 10 University of North Carolina 16010 12-0027 Approved 12-0168
2025-27 U0 University of North Carolina 16010 12-0028 Approved 12-0167
2025-27 10 University of North Carolina 16010 12-00249 Approved 12-0164
2025-27 U0 University of North Carolina 16011 11-0075 Approved 11-0510
2025-27 10 University of North Carolina 16011 11-0076 Approved 11-0480

IBIS Location: Team Content > Self-Service Reports > Budget Execution Reports
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Budget Execution Reports

»NC Agency Chart of Account Values Report (RPTRTR135)

* NCFS Location: Tools/Reports and Analytics/Browse Catalog/Shared
Folders/Custom/FBR Custom/Report/General Ledger

»BD 606 Budget Revision Report

* |IBIS Location: Team Content > Self-Service Reports > Budget Execution Reports
> BD 606 Budget Revision Report

»NC IBIS Budget Interface Reconciliation Report (RPTBE013)

* NCFS Location: Tools/Reports and Analytics/Browse Catalog/Shared
Folders/Custom/FBR Custom/Report/Budget

»RK 15 Multi Purpose Report

* |IBIS Location: Team Content > Self-Service Reports > Budget Execution Reports
> RK 15 Multi Purpose Report



Budget Execution Report: NC Agency Chart of Account Values

»NC Agency Chart of Account Values Report (RPTRTR135)

* NCFS Location: Tools/Reports and Analytics/Browse Catalog/Shared
Folders/Custom/FBR Custom/Report/General Ledger

# NC Agency Chart of Account Values Report (RPTRTR.__.

NC Agency Chart of Acco... ¥ 2 ¥ % @



Budget Execution Report: NC Agency Chart of Account Values

»NC Agency Chart of Account Values Report (RPTRTR135)

North Carolina Financial System
North Carolina Financial System Office of State Controller
NC Agency Chart of Account Values Report (RPT-RTR-135)
10/14/2025 11:30:44 AN

Parameters

CoA Structure | NC CASH

Agency 0300-OFFICE OF

THE GOVERNOR

Segments All

Fiscal Year 2026

[Enable Flag Tes

Agency Mgmt Unit NC CASH
Level 9 Level 8 Level 7 Level 6 Level 5 Level 4 Level 3 Level 2 Level 1 Child Description Enabled Start Date End Date Sort Order Summary Allow Allow
Flag Posting Budgeting
9999999 AGENCY MANAGEMENT UNIT T T N N
9999999 9999998 AGENCY MANAGEMENT UNIT SPECIFIC T T N N
9999999 9999998 0000000 DEFAULT AMU T N T T
9999999 9999998 0399999 OFFICE OF THE GOVERNOR AMU T T N N
9999999 9999998 0399999 0300001 CAPE FEAR HFH PHASEI T N T T
9999999 9999998 0399999 0300002 CAPE FEAR HFH FHASE II T N b b
9999999 9999998 0399999 0300003 SCOTLAND HFH T N T T
9999999 9999998 0399999 0300004 CRAVEN HFH T N b b
9999999 9999998 0399999 0300005 SCOTLAND COUNTY ST RENTAL SERVICES T N T T
9999999 9999998 0399999 0300006 FAYETTEVILLE HFH T N b b
9999999 9999998 0399999 0300007 RELOCATION ASSISTANCE TO RENTERS T N T T
9999999 9999998 0399999 0300008 RENTAL HOUSING ASSISTANCE T N b b
9999999 9999998 0399999 0300009 INFRASTRUCTURE GRANTS-LOCAL GOVTS T N T T
9999999 9999998 0399999 0300010 ONSLOW COUNTY CPN GRANT T N b b
9999999 9999998 0399999 0300011 LAND ACQUISTION CAPACITY BUILDING T N T T
9999999 9999998 0399999 0300012 HOUSING COUNSELORS T N b b
9999999 9999998 0399999 0300013 HOUSING RECOVERY COUNCIL T N T T
9999999 9999998 0399999 0300014 LOANS TO SMALL/MID BUSINESSES T N b b
9999999 9999998 0399999 0300015 INTEREST BUY-DOWNS T N T T
9999999 9999998 0399999 0300016 AGRICULTURE STRUCTURE,/EQUIF LOSSES T N b b
9999999 9999998 0399999 0300017 CROP LOSS ASSISTANCE T N T T
9999999 0900008 0399999 N300018 TITPLIN COTTNTY MODFEL SPRCS R ™ & &
> Agency NC CASH  Budget Fund NC CASH  Account NC CASH ~ Agency Mgmt Unit NC CASH  agency Program NC CASH  Funding Source == - i < (N




Budget Execution Report: BD 606 Report

»BD 606 Budget Revision Report

* IBIS Location: Team Content > Self-Service Reports > Budget Execution Reports
> BD 606 Budget Revision Report

Budget Revision Report

Biennium Budget Reporting Unit Budget Code

* * *
[2025-27 v [ 031-Office of State Budget and Management v [ 13005-0SEM - General v

Reference Number

Keywords:

Ype one or more ':E:r’l\':llds EEFE[EIEZ DOy Spaces.
budget Search(g]
‘Options k4

() Starts with any of these keywords

() Starts with the first keyword and contains all of the remaining keywords
@ Contains any of these keywords

() Contains all of these keywords

W Case insensitive

Results: Choice:

11-0004 - Budget Retirement Incr 4 12-0003 - RR Budget Receipt suppo
11-0005 - Budget Medical Insuran
11-0006 - Budget Health Ins Incre « Remove
11-0008 - Budget Retirement Rece

11-0011 - Budoet Request for Hea

11-0012 - Budget Retirement Incr

12-0003 - RR Budget Receipt sup]

14-0017 - Realign Budget to CD‘-’EI'

Insert &

Select all Deselect all Seleet all Deselect all




Budget Execution Report: BD 606 Report

»BD 606 Budget Revision Report

s Office of State Budget and Management %éln,s Office of State Budget and Management
%@'B’ Budget Revision for 2025-27 Budget Revision for 2025-27
Budget Reporting Unit:  031-Office of State Budget and Management Effective Date: 07/01/2025 Budget Reporting Unit:  031-Office of State Budget and Management Effective Date: 07/01/2025
Budget Code: 13005-0SBM - General Submitted Date: 09/19/2025 Budget Code: 13006-0SBM - Genoral Submitted Date: 06/19/2025
Reference No: 12-0003 Approval Date: 09/19/2025 Reference No: 12-0003 Approval Date: 09/19/2025
Refernce Title: RR Budget Receipt support Position Scientist Data Status: Approved Refernce Title: RR Budget Receipt support Position Scientist Data Status: Approved
Recurrence Type: Recurring Recurrence Type: Recurring
Statutery: M Special Provision: N Lapsed Salary: N
Account Code Account Title Fund Source Yeari Amount Year2 Amount Yeari FTE Year2 FTE Annual Salary Ty: No pecial Frovision: No P ary: No
Carry Forward: No New Grant: No Change to Existing Grant: No
Requirements Over-realized Dept Receipts: No Program Restructure: No One-Time Salary change: No
100276-GOV 1310 OFFICE OF STATE BUDGET BC 13005 Realignment. No Other. Yes
51210000 SPA-REG SALARIES 1000 (0.400) (0.400) s0 Justification:
51210000 SPA-REG SALARIES 2000 77,126 77,126 0.400 0.400 77,126 . A~ . A . " . . o N - .
¥ ¥ ¥ Per G.S. 143B-10(c) Authorizing the recrganization and changes within the organization, the revision is split funding Position 65019700. The position ks split funded between appropriation and receipts
51510000 SOCIAL SEC CONTRIB 2000 $5,900 $5,900 50 that will come from UNC and other institution to fund the Data Seientist work in the Office of state Budget and Management. The data scientist position promotes and enables evidence informed
decision making across state government. The existing appropriation funding in the position 65019700 is used to cover the appropriation side and the revision is budgeting the receipt side.
51520000 REG RETIRE CONTRIB 2000 §18,541 §18,541 $0
Total 100276-GOV 1310 OFFICE OF STATE BUDGET BC 13005 $101,567 $101,567 0.000 0.000 $77,126 ‘0SBM Remarks:
Total Requirements $101,567 $101,567 0.000 0.000 $77,126
Audit Information
Account Code Account Title Fund Source Yearl Amount Year2 Amount Yeari FTE Year2 FTE Annual Salary
Receipts
100276-GOV 1310 OFFICE OF STATE BUDGET EC 13005
47995000 OTHER MISC REV- 0000 $101,567 $101,567 50
GENERAL
Total 100276-GOV 1310 OFFICE OF STATE BUDGET BC 13005 $101,567 $101,567 50
Total Recelpts $101,567 $101,567 50
No Transfers available
Positions:
Fund Code Account Code Fund Source Number Classification Yeari FTE Year2 FTE Annual Salary
100276 51210000 1000 65019700 Data Scientist (0.400) (0.400) $0
100276 51210000 2000 65019700 Data Scientist 0.400 0.400 877,126
Total Positions 0.000 0.000 §77,126
Other Information
10/14/202511:24:00 AM 10/14/202511:24:00 AM
Page 1 of 2 Page 2 of 2




Budget Execution Report: BD 606 Report

»BD 606 Budget Revision Report

BUDGET_|BRU_CODIEFFECTIVE_DATE

1991641 031-Office
1991641 031-Office
1991666 031-Office
1991666 031-Office
1991666 031-Office
1991666 031-Office
1991712 031-Office
1991712 031-Office
1991712 031-Office
1991712 031-Office
1991712 031-Office
1997618 031-Office
1997618 031-Office
1997618 031-Office

Jull, 2025 12:00:00 AM 13005-0S
Jul1, 2025 12:00:00 AM 13005-05
Juli, 2025 12:00:00 AM 13005-08
Jull, 2025 12:00:00 AM 13005-0S
Jul1, 2025 12:00:00 AM 13005-05
Juli, 2025 12:00:00 AM 13005-08
Jull, 2025 12:00:00 AM 13005-0S
Jul1, 2025 12:00:00 AM 13005-05
Juli, 2025 12:00:00 AM 13005-08
Jull, 2025 12:00:00 AM 13005-0S
Jul1, 2025 12:00:00 AM 13005-05
Jul 1, 2025 12:00:00 PM 13005-08
Jul 1, 2025 12:00:00 PM 13005-05
Jul 1, 2025 12:00:00 PM 13005-05

BUD_BUD1 SUBMITTED_DATE

Sep 19, 2025 12:00:00 AM 12
Sep 19, 2025 12:00:00 AM 12
Sep 19, 2025 12:00:00 AM 12
Sep 19, 2025 12:00:00 AM 12
Sep 19, 2025 12:00:00 AM 12
Sep 19, 2025 12:00:00 AM 12
Sep 19, 2025 12:00:00 AM 12
Sep 19, 2025 12:00:00 AM 12
Sep 19, 2025 12:00:00 AM 12
Sep 19, 2025 12:00:00 AM 12
Sep 19, 2025 12:00:00 AM 12

Oct 14, 2025 0:15:44 AM 12

Oct 14, 2025 9:15:44 AM 12

Oct 14, 2025 9:15:44 AM 12

o1
"Doo1
o0z
"Don2
o0z
o0z
D003
D003
o003
D003
D003
o010
D010
D010

REVISION REVISIOM APPROWAL DATE

Sep 19, 2025 12:00:00 AM
Sep 19, 2025 12:00:00 AM
Sep 19, 2025 12:00:00 AM
Sep 19, 2025 12:00:00 AM
Sep 19, 2025 12:00:00 AM
Sep 19, 2025 12:00:00 AM
Sep 19, 2025 12:00:00 AM
Sep 19, 2025 12:00:00 AM
Sep 19, 2025 12:00:00 AM
Sep 19, 2025 12:00:00 AM
Sep 19, 2025 12:00:00 AM
Sep 30, 2025 12:00:00 PM
Sep 30, 2025 12:00:00 PM
Sep 30, 2025 12:00:00 PM

REFERENC STATUS RECURRENACCOUNT Account CFund Cod¢ FUMD_COI ACCOUNT ACCOUNT FUNDING_ YEARL_AI YEARZ_AI YEARL_F1YEARZ_FTANNUAL_SALARY

RR Realign Approved Recurring
RR Realign Approved Recurring
RR Chang¢ Approved Recurring
RR Changt¢ Approved Recurring
RR Change¢ Approved Recurring
RR Chang¢ Approved Recurring
RR Budge! Approved Recurring
RR Budge! Approved Recurring
RR Budge! Approved Recurring
RR Budge! Approved Recurring
RR Budge! Approved Recurring
Correct th Approved Recurring
Correct th Approved Recurring
Correct th Approved Recurring

E

AmMmmMmABAammmmaAmmmm

Requireme100276
Requireme100276
Requireme100276
Requireme100276
Requireme100276
Receipts 100276
Requireme100276
Requireme100276
Requireme100276
Requireme100276
Receipts 100276
Requireme100276
Requireme100276
Receipts 100276

100276-G'51110000 EPA-REG £1000
100276-6'51210000 SPA-REG £1000
100276-G'51220000 SPA TIME1000
100276-6'51510000 SOCIAL SE1000
100276-6'51520000 REG RETIF1000
100276-G 48100003 AGENCY 10000
100276-G'51210000 SPA-REG £1000
100276-6'51210000 SPA-REG #2000
100276-G'51510000 SOCIAL SE2000
100276-6G'51520000 REG RETIF2000
100276-G"47995000 O THER MID000
100276-G 51220000 SPA TIME2000
100276-G'51220000 SPA TIME™000
100276-G"48100003 AGENCY 10000

600
600
106,852
8,174
25,6687
140,713

101,567

-88,344
-88,344

600
600
106,852
8,174
25,687
140,713

101,567

-88,344
-88,344

-0.4
0.4

600
-600

1 106,852

-0.4
0.4




Identifying Budget Errors: RK 15

»RK 15 Multi Purpose Report

* IBIS Location: Team Content > Self-Service Reports > Budget Execution Reports
> RK 15 Multi Purpose Report

RK15 — Budget Revision Multipurpose List Report
Report Type Biennium Budget Code Type Budget Codes Budget Fund
*® gL;  Coce lowe * (202527 v * [ o-Institutional Fund a * 11000 a 013000 a
t Bﬂdgi Gode/Rund Gode level Bl 1-General Fund 12000 0 100200
(O Account level [[] 2-Capital Improvement Fund 12001 100201
) [[] 2-special Fund 13000 100202
[[] 3-Federal Fund 13001 100203
[[] 5-Enterprise Fund 13005 100204
[[] 6-Capital Improvement Func 13006 100205
[[] 6-Trust Fund v 13010 100208
— 13050 - 100207 -
‘ — ' 42N0OE ANNaNo
Select all Deselect all Select all Deselect all Select all Deselect all
Click here for Budget Codes Click here for Budget Fund(s)
Account Groups Accounts Revision Type Status
41999999 a 56100029 a *ALL ° @ Approved
42999999 56100030 (] 1t O Draft
43999999 56100031 12 (L OSBM
44999999 56100032 14
45999999 56100033
46999993 56100034
47099999 56100036
48999999 56100037
49099999 - 56100038 -
FinAGann Fasnnnnn
Select all Deselect all Selectall Deselect all Select all Deselect all
Click here for Accounts




Identifying Budget Errors: RK 15

e Using the RK 15

YTD Certified Budget YTD Authorized Budget Current Period Actuals QTD Actuals YTD Actuals Certified Balance Authorized Balance
T - - - - - -
(310,000.00) 311,338.00 0.00 0.00 0.00 (310,000.00) 311,338.00
%@’B’S RK15 - Budget Revision Multipurpose List Report
44 Revisions at Budget Code Level

2023-24 2024.25
Revision # Status Approval Dt Actual Dt Requirements Receipts Appropriation Positions Requirements Receipts Appropriation Positions Budget Revision Title
Approved $621,338 $0 $621,338 0.000 $621,338 30 $621,338 0.000 Original Appropriation Bill
12-0165 Approved  03/31/2024  04/05/2024 $0 $0 $0 0.000 50 50 $0 0.000 SPSF PRC 055 AMU 08X0055 Align
12-0651 Approved  06/29/2024  08/05/2024 ($621,338) $0 ($621,338) 0.000 50 50 30 0.000 SPSF BF 101180 Year-End Adjust
11-0865 Approved  03/31/2025 03/31/2025 50 50 50 0.000 ($310,000) 50 ($310,000) 0.000 SFSF CIHS PRC 055 Transfer to

12-1454 Approved  06/29/2025 07/30/2025 50 $0 $0 0.000 $50 50 $50 0.000 101180 SPSF dollar allotment r




Identifying Budget Errors: Budget Interface Reconciliation

»NC IBIS Budget Interface Reconciliation Report (RPTBE013)

* NCFS Location: Tools/Reports and Analytics/Browse Catalog/Shared
Folders/Custom/FBR Custom/Report/Budget

* Requires NCFS Journal Inquiry Role

4 NC IBIS Budget Interface Reconciliation Report (RPT

E& Budget Creation - To Date 10-14-2025 E"e Apply




Identifying Budget Errors: Budget Interface Reconciliation

»NC IBIS Budget Interface Reconciliation Report (RPTBE013)

North Carolina Financial System
Office of State Controller
NC IBIS Budget Interface Reconciliation Report (RPT-BE-013)

Warth Cavaling Financial System

Parameters
Control Budget:  |[NC Certified NC
Authorized]
Agency: 0300-CFFICE OF THE
GOVERNOR
From Date: 10/10/2023
To Date: 10/14/2023
Source Application Control Budget Drata Set Import Mode Stams Period ‘Currency Batch Line Amount Context Revision | Revision Budget Approval File |Agency|Budget Fund| Account |Management| Progra | Funding | Project |Inter Fund | Future 1| Future 2 |Future 3
Creation | Number Type Number Code Date Name Unit m Source
Doate
Hyperon Flaning |INC Authorized FY2023-2027 TYFE Increment COMFLETED Sep-23 usD 10/10/2023 21 S000|BI: Details 14 03T 23000 09/01/2023 201024 31576000 [030L461 Q000000 [2000 QOODDOC000 [GD0000 000D 000000 [0OD0D
REVISIONS - 0300 23000
140037 TIME 10 10 2025
-08 3l 38
Hyperion Flanning |NC Authorized FY2023-2027 TYFE Increment CCMLPLETED Sep-25 uUsD 10/10/2025 565 -30.00|IBIS Detil: |14 0037 23000 09/01,/2025 201024 51180000 [0301461 0000000 [2000 ‘0000000000 (000000 000D 000000 00000
BEWISIONS - 0300 23000
140037 TIME 10 10
- 083138




Allotment Reports

»RK 457 Allotments Summary Report

* |[BIS Location: Team Content > Self-Service Reports > Budget Execution
Reports > RK 457 Allotments Summary Report

»NC Allotments to Cash Availability (702) Report (RPT-BE-012)

* NCFS Location: Tools/Reports and Analytics/Browse Catalog/Shared
Folders/Custom/FBR Custom/Report/Budget

»FBR IBIS Allotment Interface Reconciliation Report

* NCFS Location: Tools/Reports and Analytics/Browse Catalog/Shared
Folders/Custom/FBR Custom/Report/Budget



A

»RK 457 Allotments Summary Report

* IBIS Location: Team Content > Self-Service Reports > Budget Execution Reports
> RK 457 Allotments Summary Report

viCIBIS

13005- State Budget an

d Management - General Fund

Office of State Budget and Wanagement
RK 457 Allotment Summary by Budget Code

Fizcal Year: 2025-2026

Authorized Gross
Description Budget First Quarter Second Quarter Third Quarter Fourth Quarter ¥TD Total| Reversion YTO Total with Remaining From
Allotment Reversion Allotment Authorized
2025-2026 JULY  AUGUST SEPFTEMBER QI1TOTAL| OCTOBER HNOVEMEER DECEMBER 32 TOTAL JANUARY FEBRUARY MARCH 03 TOTAL| APRIL MAY JUNE Q4 TOTAL
Fegquirements 13.188.076| 3.074,337 a 23N 3,387,338 3.242,160 0 1} 3.242,160 0 0 0 0 0 0 0 0| 6623435 0 6,629,435 5553578
Receipts 1509883 260,000 a 217,303 477903 342245 0 1} 342,245 0 0 0 0 0 0 0 0 520148 0 20,145 633,741
Appropriation 673,187 2.814.937 a 34,438 2.909.435 2.893.915 0 1} 2893915 0 0 0 0 0 0 0 0| 5809350 0 5.809.350 5.869.837
Morthly > Allated 24103 0.00: 0.8%: 2491 2453 0.00: 0.00: 24.83% 0.0 0.00: 0.0 0.00% 000 0.00 000 0.00: 43T 43,74 50.26%
Cummulative 0 Allated 2491 45,7 43,74 43,74
02026 11 0531 Ak




~ .

»NC Allotments to Cash Availability (702) Report (RPT-BE-012)

* NCFS Location: Tools/Reports and Analytics/Browse Catalog/Shared
Folders/Custom/FBR Custom/Report/Budget

# NC Allotments to Cash Availability (702) Report (RPT._. Home Catalog Favorites v Dashboards v Createw Openw 9

Agency 0300-OFFICE OF THE GOVE w Budget Code 13005-0OFF OF STATEBUDC w Budget Fund All v Period Current Period v  Apply

NC Allotments to Cash A...

N
Bl

v{}@




A

»NC Allotments to Cash Availability (702) Report (RPT-BE-012)

CF North Carolina Financial System
vt Carofng FhnancialSystes Office of State Controller
INC Allotments to Cash Availability (702) Report (RPT-BE-012)
10/15/2025 01:30:44 PM

Parameters
Agency 0300-OFFICE OF THE

GOVERNOR
Budget Code 13003-OFF OF STATE BUDGET

AND MANAGE
Budget Fund All
Period Sep-I5
Budget Code 13003-0OFF OF 3TATE BUDGET

AND MANAGE

Titles Budget TUnalloted Allotted ‘Current Month ‘Quarter To Date Year To Date Unexpended
Expendimres 13,180.076.00 0,801,738.00 3.387338.00 07TE 37350 22410470 2410470 0o4407121
Revenues 1,300.250.00 1,051,086.00 477,205.00 206,840.31 47790202 47790202 1,031.986.08
Excess of Expendimure - Over 11,679.187.00 E,Te0, 73200 2.000.435.00 TT1,730.08 276820187 276620187 01298513
{Under) Revenues
Analyeis of Cash ‘Current Month ‘Quarter To Diate Year To Date

Beginning Balance 820,52821 0.00 0.00
Add:

(+] Allotments/ Revisions 8443800 2000 43500 200043300
Less

(-} Reversions 0.00 0.00 0.00

{-) Excess per BDT0L T71,733.08 276620187 2,766,201.87
Changes In
Aseets,/Liability, Owners Equity
Direct from Cash Accounts;

0.00 0.00 0.00 0.00

Met Asseis/ Liabilities,/ Equity 0.00 0.00 0.00 0.00

Ending Balance 143,233.13 143.233.13 143,233.13

Unexpended Appropriations 5P12085.13

YTD Allotment Information Allotted ‘Current Month ‘Quarter To Diate Year To Date Unexpended ¥YTD

Expenditures I2HL104TR 32410478 14323321
Receipts 206,840.51 477 80282 477 80282 0.08
Asgets/ Liabilities / Equity 0.00 0.00 0.00 0.00
Met Allomment 2.000.433.00 77173008 276620187 276620187 14333313




7%¢IBIS

Office of State Budget and Management
RK 457 Allotment Summary by Budget Code

Fiscal Year: 2025-2025

13005- State Budget an - General Fund
uthorize: Gross
Description Budget First Quarter Second Quarter Third Quarter Fourth Quarter “TO Total Reversion YTD Total with Remaining From
Allotment Reversion Allotment Authorized
2025-2026 JULY  AUGUST  SEPTEMBER HQ1TOTALL OCTOBER NOYEMBER DECEMBER G2 TOTAL| JANUARY FEBRUARY MARCH G3TOTAL| APRIL  MAY JUNE Q4 TOTAL
Requirements 13,189,078 3.074.937 0 312,31 3.387.33 3242160 0 a 3242180 0 0 a 0 0 0 0 0] 6623435 0 E,629,433 6,553,573
Receipts 1503859 260000 a 217,903 477,30 342,245 a a 342,245 a a a a a a a a 520, 14a| o G20, 145 633,741
Appropriation N.E73.189 2514937 0 34,435 2,909,435 2833915 0 a 2,893,915 0 0 a 0 0 0 0 0] 5.803.350 0 5,803,350 5,869,837
Monthly > &lloted 2490 0.00: 051 24.91 2483 0.00: 0.00: 24.83 0,00 0,00 0.00: 0.00 000 000 000 0.00: 49,745 50.26%
Cummulative ¥ Allated 4 1, 43,744 43,7 43. 734
AN ZE 1105 31 4AM
Budget Code 13005-OFF OF STATE BUDGET
AND MANAGE
Titles udget Unallotted Allotted Current Month Quarter To Date Year To Date Unexpended
Expenditures 13,189,076.00f 9.801,738.0 3,387,338.00 97857339 3,244 10479 3,244 10479 9.944.971 21
Revenues 1,509,889.00f 1,031,986.0 477,903.00§ 206,840.51 47790292 47790292 1,031,986.08
Excess of Expenditure - Over LL,GTEI,LBT.DDI 8.769.752.0 2909 435.0 771,733.08 2766,201.87 2766,201.87 8.912.985.13
{(Under) Revenues




Allotment Interface Reconciliation Report

FBR IBIS Allotment Interface Reconciliation Report Home Catalog Favorites » Dashboards » Create Openw
* Journal Source [BIS Interface v
Allotment Number All v
Batch Creation - From Date i Batch Creation - To Date 11-13-2025 [@ Apply
Ledger | Journal Name Source Caregorv Period | Acmal | Currency Batch Line | Context | Allotment Revenue | Expenditure Entered Entered
Flag Creation MNumber Amount Amount Debit Credit
DNC CASH [Allotment IBIZ Intecface (IBIS GF Zep-23 |A UsD 10/15/20252 IEI= 010218 217.9053.00 217903500 0.00 0.00
Us Imported AILLOTMENT GEMEFRA
AGEMNCY L FUND
20230030 10 15 ALLOTM
2025-0501 11 ENT
IBIZ GF
ALLOTMENT
Budget | FileNam | Agency Budget Account Mgmt Program | Funding Project Inter Fund | Future 1 | Future 2 | Fumre 3
Code e Fund Unix Source —
TT - - - - - - - - - - - -
11120000  [DOO0000 QOODOOD  [OD0O0 QOODOODO0D  [COOO0D Q000 HEEEEH QO000

_ 3
ol emes_ 3
lotment.c
sv. 202510
15020501,
pgp_1015
2025-05

0111




Closeout Reports

UNC Budget Closeout Job Aid — Appendix (Page 14)
* State Budget System Links

* IBIS-NCFS Report Comparison

* |BIS Reports for Closeout

* NCFS Reports for Closeout

* Security Roles Needed for Closeout


https://www.osbm.nc.gov/media/3728/download?attachment

Previous Month, Current Month, June of Previous FY Reports

» Three sets of reports: Previous Month, Current Month and Year-End for
both:

e Comparison of the BD 701 and RK325 (All Segments)
* Negative Budgets

» Previous Month — Pulls data from prior fiscal period
* |BIS Location: Team Content > System Run Reports > Budget Execution Reports

» Current Month — Pulls data from Current fiscal period
* |BIS Location: Team Content > System Run Reports > Budget Execution Reports

»June of Previous FY — For use in August during year-end closeout, when
previous month and current month reports no longer work look at June

* |BIS Location: Team Content > System Run Reports > Year End Closing Previous Month
Reports



Closeout Reports: IBIS-NCFS Reconciliation

» Previous Month Comparison of BD701 and RK325

* |IBIS Location: Team Content > System Run Reports > Budget Execution Reports
> Previous Month Comparison of BD701 and RK325 (NCFS Segments)

Previous Month Comparison of BD701 and RK325 for period 03 and Fiscal Year 2026
Report executed on : Oct 17, 2025 6:00:00 AM
1011612025 09/30/2025
05C Project Coc¢ * | OSC Inter Fu| ~ |1BIS AMU Cod * | 1BIS Program Coc = | IBIS Fund Sourc * |1BIS Fund Sour * | IBIS Inter Fui * | O5C Actual Amou v | O5C Certified Amou v | OSC Authorized Amou v | RK325 Certified Amou » | RK325 Authorized Amou | Certified Amount Differen * | Authorized Amount Differen| »
*0000000000 000000 M101113 1100LAD "i000 *0000000000 000000 50.00 £183,691.00 0.00 2471 962.00 _a71 962 (8471,962.00)
'B000000000 "Booooo 101113 1100LAD 000 "B000000000 "Bo0000 50.00 $14,412.00 50.00 §36,105.00 -36,105
"0000000000 000000 101113 1100LAD "1000 "0000000000 000000 50.00 $46,476.00 50.00 5116,433.00 -116,433
"B000000000 "Booooo 101113 1100LAD 000 "B000000000 "Bo0000 0.00 §12,953.00 £0.00 5
"B000000000 "Booooo "boooooo "boooo00 2000 "B000000000 "Bo0000 50.00 5400,000.00 50.00 5
"bo0oo00000 "Booooo "ooooooo "ooooo0o 2000 "Bo00000000 "aoo000 510,915.58 §27 667.00 50.00 92
'B000000000 "Booooo "boooooo "boooooo 2000 "B000000000 "Bo0000 §2,983,186.85 57 678,609.00 50.00 36
"0000000000 000000 0000000 0000000 "2000 "0000000000 000000 558,0 50.00 0 )
"B000000000 "Booooo "boooooo "boooo0o 2000 "B000000000 "Bo0000 £0.00 18,630 (512,588.00)
"B000000000 "Booooo "boooooo "boooo00 2000 "B000000000 "Bo0000 50.00 53,212 (53.00)
"bo0oo00000 "Booooo "ooooooo "ooooo0o 2000 "Bo00000000 "aoo000 50.00 §1,774,161.00 826 245 (81,774,161.00)
'B000000000 "Booooo "boooooo "boooooo 2000 "B000000000 "Bo0000 50.00 580,000.00 580,000.00 -59,000 (580,000.00)
0000000000 600000 "to00000 "t000000 2000 0000000000 00000 50.00 575,000.00 575,000.00 -38,500
"B000000000 "Booooo "boooooo "boooo0o 2000 "B000000000 "Bo0000 £0.00 £20,000.00 §20,000.00 -20,000
"B000000000 "Booooo "boooooo "boooo00 2000 "B000000000 "Bo0000 50.00 57,628.00 57,628.00 6,376
"bo0oo00000 "Booooo "ooooooo "ooooo0o 2000 "Bo00000000 "aoo000 50.00 265,483
'B000000000 "Booooo "boooooo "boooooo 2000 "B000000000 "Bo0000 5198,286.00 50.00 73,000
0000000000 600000 "to00000 "t000000 2000 0000000000 00000 5148,176.00 50.00 -151,320
"B000000000 "Booooo "boooooo "boooo0o 2000 "B000000000 "Bo0000 §2,184.00 £0.00 -480
'B000000000 "Booooo "boooooo "boooooo 2000 "B000000000 "Bo0000 5§720.00 50.00 -2,380
"bo0oo00000 "Booooo "ooooooo "ooooo0o 2000 "Bo00000000 "aoo000 $600.00 50.00 0
"B000000000 "Booooo "boooooo "boooooo 2000 "B000000000 "Bo0000 50.00 50.00 §25,020.00 §25,020.00 -25,020 ,020.00}
0000000000 600000 "to00000 "t000000 2000 0000000000 00000 52,500.00 50.00 570,000.00 570,000.00 67,500 (570,000.00)
0000000000 600000 0000000 0000000 2000 6000000000 00000 £165,000.00 £0.00 £185,090.00 £185,090.00 20,090 (%185,090.00)
'B000000000 "Booooo "boooooo "boooooo 2000 "B000000000 "Bo0000 5180,000.00 50.00 $220,000.00 -30,000 (5220,000.00)
"bo0oo00000 "Booooo "ooooooo "ooooo0o 2000 "Bo00000000 "aoo000 §3,000.00 50.00 §2,500.00 500 (52 500.00)
"B000000000 "Booooo "boooooo "boooooo 2000 "B000000000 "Bo0000 $34,500.00 50.00 §15,000.00 19,500 (515,000.00)
0000000000 600000 "to00000 "t000000 2000 0000000000 00000 50.00 50.00 51,500.00 1,500 (81,500.00)
0000000000 "Bo0ooo "booo0oo B000000 2000 0000000000 "bo0000 50.00 50.00 5500.00 -500 )
'B000000000 "Booooo "boooooo "boooooo 2000 "B000000000 "Bo0000 5402,896.00 50.00 $675,685.00 272,789
"bo00000000 "Booooo "boooooo "oooo000 2000 "Bo00000000 "bo0000 54,000.00 50.00 $7,500.00 -3,500
"B000000000 "Booooo "doooooo "boooooo 2000 "B000000000 "Bo0000 §5,000.00 50.00 §5,000.00 0
"B000000000 "Booooo "boooooo "boooo00 2000 "B000000000 "Bo0000 5500.00 50.00 51,500.00 51,500.00 -1,000
0000000000 "Bo0ooo "booo0oo B000000 2000 0000000000 "bo0000 §2,500.00 50.00 §2,500.00 §2,500.00 0 y
'B000000000 "Booooo "boooooo "boooooo 2000 "B000000000 "Bo0000 §73,500.00 50.00 5$140,000.00 5140,000.00 66,500 (5140,000.00)
"0000000000 "Booooo "ooooooo "oo00000 2000 "0000000000 "bo0000 §1,500.00 50.00 50.00 50.00 1,500 50.00




Closeout Reports: Negative Budgets

» Previous Month Negative Budget

* |BIS Location: Team Content > System Run Reports > Budget Execution Reports

> Previous Month Negative Budget (Cert/Auth)

/

\

?’MIBIS rious Month Negative Budget (Cert/Auth) for period 03 and Fiscal Year . ¢ &
Report executed on : Oct 17, 2025 6:32:00 AM
10/16/2025

BRU Budget Code Budget Fund Account Code Fund Source 0OSC Actual Amount  OSC Certified Amount 0SC Authorized Amount
020-Administrative Office of the Courts 22001 200157 52199900 (517,030.00) $0.00 ($16,494.00)
020-Administrative Office of the Couris ®2006 ®o0920 %1160000 2000 $796 507 20 $297 392.00 (51,484 821.00)
031-Dffice of State Budget and Management F3005 Flo0276 %72068000 $0.00 (5452.00) (5452 .00)
031-Office of State Budget and Management F3005 F00276 %7208000 $0.00 (5243.00) (5243.00)
050-Department of Secretary of State Fi3200 Fo0601 %7206000 $0.00 ($9,328.00) ($9,328.00)
030-Department of Public Instruction 3510 F01033 1664000 1300 $360.00 ($200.00) $800.00
030-Department of Public Instruction F13510 F101041 2170002 $34 516.80 (515,523.00) ($15,523.00)
080-Department of Public Instruction F3510 Fio1180 %E500142 $1,207 234 68 (59,000,000,000.00) (58,000,000,000.00)
080-Department of Public Instruction F3510 Fi01190 %7100137 $0.00 (§1,848 573.00) (51,848 573.00)
090-Department of Justice F3800 F01202 7100030 $0.00 ($3,042 126.00) ($3,042 126.00)
[120-Department of Insurance %2003 02340 2521000 $27 655.75 $0.00 ($30,493.00)
[150-Department of Transportation B4210 ©201052 %7100005 $0.00 ($581,441.00) ($581,441.00)
[150-Department of Transportation %4210 01278 7100005 $0.00 ($633,935874.48) ($633,935874.48)
150-Department of Transportation 34210 301310 7100005 $0.00 ($5,653,270.29) ($5,653,270.29)
160-Deparment of Environmental Quality F4300 Fl02176 %2812000 51066212 50.00 (53,386.00)
160-Deparment of Environmental Quality F4300 Fio2176 %3120000 $141.54 (54, 032.00) (54 032.00)
160-Department of Environmental Quality F4300 Fo2182 51420000 200K $0.00 (5144.00) $0.00
[160-Department of Environmental Quality F4300 Fioz1g2 %1631000 230K $0.00 ($262.00) $0.00
[160-Department of Environmental Quality F4300 Fioz1g2 %1639000 230K $0.00 ($13.00) $0.00
[160-Department of Environmental Quality F4300 Fioz182 %2731000 $767.00 ($104.00) $0.00
[160-Department of Environmental Quality F4300 Fin2182 %2732000 5163286 (5185.00) 50.00
160-Deparment of Environmental Quality F4300 Fi02186 %2210000 $0.00 (51,699.00) (51,699.00)
160-Deparment of Environmental Quality F4300 Fl02186 %2521000 $0.00 (§25,592.00) (§25,592.00)




Closeout Reports: Check Fund Source and Program

»NC Budget to Actual (701) Excel Report (RPTRTR019)

Period |Fiscal Year| Agency Agency Budget Budget Budget Budget Account | Account [ Account AMU AMU Agency Agency Funding [ Funding |YTD Certified YID Current QTID YID
Descriptio Code Code Fund Fund Type [Descriptio Descriptio | Program § Program Source Souree Budget Authorized Period Acmals Actuals
5 2026 Uloe  |UNC 16010 |UNC-GA 150005 |141 PBSNC |[REVENUE| Saip0000 |OTHER 0000000 |DEFAULT | UO0L1141 |UNCCPFIV Booe [’}.’DEHG 15.049.00 15.049.00 0.00 Q.00 0.00
SYSTEM UNCS0 BC SALES & AMUT NATED
) 2026 Uloe  |UNC 16010  |UNC-GA 130003 |141 FESNC |[REVENUE| 44321000 (SALE OF 0000000 |DEFAULT | U001141 |[UNCCPTV D000 UNDESIG 21,000.00 21,000.00 0.00 0.00 0.00
SYSTEM UNCE0 BC SURF AMU NATED




-~ Closeout Reports: Type 14 Revisions

Use of 57xxxxxx and 58xxxxxx Accounts

* Run the IBIS RK 15 report for 57xxxxxxx and 58xxxxxx accounts for the
university’s General Fund budget code.

* Recommend the RK 15 in batches for the 57xxxxxx and 58xxxxxx
accounts separately to speed up processing in IBIS.

Budgeting Receipts/Revenue up to Type 14 Receipt Thresholds

e Use the Type 14 Revisions Audit Report to confirm that receipts have
been budgeted up to no more than the OSBM-delegated threshold for
Type 14 Internal Revisions

IBIS Location: Team Content > Self Service Reports > Budget Execution
Reports



Closeout Report: Use the RK 325 to reconcile FTE

Use the RK 325 Certified and Authorized Budget Report (RK 325)
— Select the Detail by Account (FTE) Report Type to check
certified and authorized FTE for closeout reconciliation

Certified And Authorized Budget Report (RK 325)

Report Type Biennium Approval Date

* OALL * [ 2025-27 v * Nov 10, 2025 -
() Summary By Fund (Dollars)

() Summary By Account (Dollars)
@® (O Detail By Account (Dollars)

() Summary By Fund (FTE)

() Summary by Account (FTE)

(@ Detail By Account (FTE)

Budget Code

Budgetary Reporting Unit

*|BRU v




-~ RK 317 Journal Entry Report

For OSC Closeout, use the RK 317 Journal Entry Report — JE/BC

Balances Option to check that all budget revisions with journal entries
have been approved, including the journal entry portion.

Journal Entry/Budget Codes and Fund Code Balances

- Report Type
* (@ JE/BC Balances

(C)Change in Fund Code Balances

entry is approved

This column will show a
number once the journal

Biennium

Volume

* | 2025-27

v| *[1-Education

oroormversny of North Carolina
16011-UNC Board of Governors - Institutional Programs

Journal Entries and Budget Code Balances

Biennium 2025-27

- 2025-26 2025-26 2026-2027 2026-2027
‘é?:t':;";l :“'5'0" gﬂ&mm Iﬁ:f;:: Description Authorized Balance Authorized Balance
Change Certified Balance Ehanga Certified Balance
GOE71 110049 10/24/2025 16088 EY26 Enroll L Ch Budoet ADJ (51,282 173) $107 638,681 ($1,282173) $113,685,490
) Areiment Lhange Budge $107,638 681 $113,685,490
2,420,503 105,218,178 2,420,503 111,264 987

G-0671 11-0049 10/24/2025 16080 FY 26 Enrollment Change Budget ADJ (8 ) i (3 ) 5
$105,218,178 $111,264 987
(5474,313) $104,743, 865 ($474,313) $110,790,674
G-0671 11-0049 10/24/2025 16082 FY 26 Enrollment Change Budget ADJ $104 743 865 $110.790.674




Resources

Type 14 Revisions
* Internal Budget Revision Receipt Adjustment Threshold

e State Budget Manual (updated for FY 2026)
* UNC Budget Revision Authority Guide

Reports
e UNC Closeout Job Aid — Appendix (Page 14)



https://www.osbm.nc.gov/budget/common-agency-requests/internal-budget-revision-receipt-adjustment-threshold
https://www.osbm.nc.gov/budget/common-agency-requests/internal-budget-revision-receipt-adjustment-threshold
https://www.osbm.nc.gov/budget/budget-manual
https://www.osbm.nc.gov/budget/budget-manual
https://www.osbm.nc.gov/unc-budget-revision-authority-guide/download?attachment
https://www.osbm.nc.gov/unc-budget-revision-authority-guide/download?attachment
https://www.osbm.nc.gov/media/3728/download?attachment
https://www.osbm.nc.gov/media/3728/download?attachment
https://www.osbm.nc.gov/media/3728/download?attachment
https://www.osbm.nc.gov/media/3728/download?attachment

First Friday Trainings

* UNC Revisions and Reporting (materials and recording soon)
* Appropriations Act 101

* UNC System Capital Budgeting

* UNC Budget Revisions 101

* UNC Carryforward and Closeout

Upcoming: Allotments and Cash Management
* OSBM and OSC, in person at NCSU Conference


https://www.osbm.nc.gov/budget/training-resources/first-friday-training-series

Stay in Touch

Phone:
984-236-0600

Website: www. osbm.nc.gov

Follow us:
@ NC Office of State Budget & Management

A@S B M @ NCDemographer

OFFICE OF STATE BUDGET
AND MANAGEMENT )
> @ NC Office of State Budget & Management
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